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บทคัดยอ 

 บทความนี้มีวัตถุประสงคเพื่อนําเสนอวิธีการใชโปรแกรม Nuendo เพื่อการสรางเสียงประกอบสื่อผสมที่มีการผสมกัน
ระหวางวิดีโอและเสียง โดยจะมีการอธิบายถึงวิธีการใชและการตั้งคาตางๆในโปรแกรม Nuendo รวมถึงการตัดตอ จัดวางและ
ตกแตงเสียงตางๆ การใชเอฟเฟค(Effect) ประเภทคอมเพรสเซอร(Compressor) และรีเวิรบ(Reverb) รวมถึงการ Export ไฟล
วิดีโอหลังจากเสร็จสิ้นกระบวนการ ซึ่งบทความนี้ไดขอสรุปวาในการทํางานทางดานเสียงควรมี Audio Interface ใชงานรวมกับ
โปรแกรม Nuendo โดยการสรางงานน้ันจะมีเรื่องของการตัดตอและตกแตงเสียงเขามาเกี่ยวของ เพื่อใหไดเสียงที่ดีและมีคุณภาพ
มากยิ่งขึ้น และโปรแกรม Nuendo สามารถใชงานเพื่อสรางงานเสียงประกอบภาพยนตร งานเสียงประกอบโฆษณา รวมถึงงาน
ทางดานดนตรี หรือเสียงประกอบสื่อตางๆไดเปนอยางดี นอกจากนี้ Nuendo ยังมีความสามารถในการ export วิดีโอไดแตก็มี
ขอจํากัดดวยเชนกัน คือสามารถ export ในรูปแบบของไฟลนามสกุล .mp4 codec H.264 สวนทางดานเสียงจะไดความละเอียดที่ 
16 bits 44.1 kHz และ 16bits 48 kHz ขนาดภาพที่ 1920 x 1080 px (Full HD) เทาน้ัน 
 

คําสําคัญ : การสรางเสียง, สื่อผสม, นูเอ็นโด 

 
Abstract 

 This article is intended to explain the process of creating audio for mixed media by Nuendo. This article 
introduces how to create a multimedia sound between video and audio. A various settings in the program, 
cutting, editing, Using effect process to the desired image sound effects by Nuendo. This article concluded that 
in audio work, should be used Audio Interface with Nuendo to creating work for better sound and more quality. 
Audio editing is important too. Nuendo can working for a sound recording, audio editing. Which users can use 
Nuendo to create a movie sound effects. Including a work of music and advertise, various sound effects for 
multimedia as well. Nuendo is also capable of exporting videos. But it also has a limitation, it can be exported 
as .mp4 codec H.264, audio output at 16 bits, 44.1 kHz and 16bits. 48 kHz Image size at 1920x1080px (Full HD) 
only. 
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บทนํา 
 หากจะกลาวถึงเรื่องการทํางานดานวิศวกรรมเสียงในยุคปจจุบันนั้นก็ตองกลาวถึงการพัฒนาของเทคโนโลยีที่มีการ
เปลี่ยนแปลงและเพิ่มประสิทธิภาพไดอยางรวดเร็ว สื่อทุกชนิดสามารถเผยแพรออกไปไดอยางรวดเร็วผานโลกออนไลนหรือสิ่งที่
เรียกวาอินเทอรเน็ต โดยสามารถทํางานผานอุปกรณเพียงแคคอมพิวเตอรสวนตัวเครื่องเดียวก็สามารถสรางสื่อออกมาได เสียง
สามารถถูกบันทึกผานกระบวนการแบบดิจิตอล ทุกอยางสามารถประมวลผลและแสดงผลผานทางจอคอมพิวเตอร และสามารถ
ควบคุมการทํางานไดดวยคียบอรดและเมาส(Knoebl, 2016) การทํางานสื่อในยุคขอมูลขาวสารที่อยูในรูปแบบสื่อดิจิตอลถือไดวา
เปนตัวเรงที่ทําใหเกิดการเปลี่ยนแปลงและมีประสิทธิภาพทางดานการรับรูและเผยแพรสื่อ เนื่องจากส่ือมัลติมีเดียสามารถเผยแพร
ทั้งในรูปแบบขอความ เสียง วิดีโอ ซึ่งมีอิทธิพลกับการใชชีวิตประจําวันของเราเปนอยางมาก(Rahman, 2008) อวัสดากานต(2563) 
กลาววา ในยุค  ปจจุบัน สื่อออนไลน และชองยูทูบ(Youtube) เปนสื่อที่สามารถเขาถึงผูรับสาร ผูชม ผูฟงไดมาก เนื่องจาก
เทคโนโลยีที่พัฒนาขึ้นในปจจุบัน สงผลใหเกิดความเปลี่ยนแปลงในพฤติกรรมของผูบริโภค และคานิยมที่เปลี่ยนไปในการรับชม
ความบันเทิง ขาวสาร บทเพลง รายการตางๆ การนําบทเพลง มิวสิควิดีโอ การแสดงสด ของศิลปนในคาย จึงเปนสิ่งสําคัญในการ
ประชาสัมพันธ ทําใหบทเพลงไดรับความนิยมไดอยางรวดเร็ว ดังนั้นเสียงจึงเปนสวนสําคัญเปนอยางมากในการสรางสื่อ 
Holmam(2010) ไดกลาวไววา ไมวาจะเปนงานสื่อที่เปนภาพยนตรหรือส่ือที่เผยแพรทางโทรทัศนน้ันลวนแลวเกิดจากประสบการณ
ที่เกิดจากการฟง เนื่องจากเสียงสามารถถายทอดเรื่องราวตางๆสูผูฟง ไมวาจะเปนการถายทอดเรื่องราวจากทางตรงหรือทางออม
เพื่อใชในการสนับสนุนเรื่องราวที่เกิดขึ้น 

 ในยุคแหงเทคโนโลยีดิจิตอลที่ทํางานดวยระบบคอมพิวเตอรนั้นผูใชงานมีทางเลือกมากมายที่จะเลือกโปรแกรมในการ
สรางสื่อ ไมวาจะเปนการทํางานดวยระบบของแมคโอเอส(MacOS) หรือวินโดว(Windows) ผู ใชก็สามารถสราง มิดิ (Midi) 
บันทึกเสียง การสรางโนตเพลง รวมถึงการตกแตงเสียงและผสมเสียง และโปรแกรมนูเอ็นโด(Nuendo) ก็เปนหนึ่งในโปรแกรมที่
สามารถใชงานในการสรางเสียงประกอบวิดีโอได Collins(2004) ไดกลาวไววาโปรแกรมนูเอ็นโดเปนโปรแกรมที่ถูกพัฒนาจาก
บริษัทสเตนเบิรก(Steinberg) ไดมีการใชงานครั้งแรกในป 2000 ซึ่งนูเอ็นโดนั้นไดรับการยอมรับเปนอยางมากในดานการสรางระบบ
เสียงรอบทิศทาง โปรแกรมนูเอ็นโดนั้นมีการแขงขันทางดานการใชงานกันอยางเขมขนกับโปรแกรมโปรทูล(Pro Tools) แต
โปรแกรมนูเอ็นโดก็มีจุดเดนมากกวาโปรทูล(Pro Tools) ที่การสรางและผลิตงานดนตรีที่อยูในระบบมิดิ(Midi)และการเขียน
โนตเพลง เนื่องจากการใชงานของนูเอ็นโดนั้นมีความงายและสะดวกสบายมากกวาเนื่องจากสามารถใชอุปกรณเชื่อมตอไดอยาง
อิสระ สามารถใชเอเอสไอโอไดรเวอร(ASIO Driver) ตางกับโปรแกรมโปรทูลที่ตองใชอุปกรณเชื่อมตอที่ถูกบังคับเทาน้ัน 
 จากที่กลาวมาขางตนน้ีผูเขียนบทความเล็งเห็นวาการทําเสียงประกอบสื่อผสมหรือสื่อตางๆนั้นเสียงมีความสําคัญเปนอยาง
มาก เนื่องจากเสียงจะสามารถบงบอกลักษณะ ตัวตน และเอกลักษณของสื่อนั้นๆได ประกอบกับยุคสมัยปจจุบันนิยมใชสื่อเพื่อ
เผยแพรทางโลกออนไลนเปนอยางมาก จึงไดทําการเขียนบทความนี้ขึ้นมาใหผูที่สนใจไดศึกษาแนวทางการใชโปรแกรมนูเอ็นโดใน
การสรางเสียงได 
 

วัตถุประสงคของบทความ 
 บทความเรื่องการสรางเสียงประกอบสื่อผสมดวยโปรแกรม Nuendo มีวัตถุประสงคเพื่อรวบรวมขอมูล และองคความรูใน
ดานการใชโปรแกรม Nuendo เพื่อการสรางเสียงประกอบสื่อผสมประเภทวิดีโอ บทความมุงเนนไปทางดานกระบวนการการตัดตอ
เสียงและการใชเอฟเฟคเสียงเพื่อทําใหเสียงมีความสมดุลและตอเนื่องกัน 
 

การรวบรวมขอมูล 
 การศึกษาเรื่องการสรางเสียงประกอบสื่อผสมดวยโปรแกรม Nuendo ผูเขียนไดมีการรวบรวมขอมูลจากหนังสือ งานวิจัย 
บทความและเอกสารที่เกี่ยวของ รวมถึงขอมูลจากเว็ปไซตตางๆ ซึ่งทฤษฎีและแนวคิดที่เกี่ยวของจะเปนการแปลมาจากหนังสือและ
คูมือจากตางประเทศ และขอมูลในภาคปฏิบัติในการใชโปรแกรม Nuendo ผูเขียนไดมีการแปลมาจากคูมือการใชงานที่เขียนโดย 
Steinberg media Technologies โดยผูเขียนมุงเนนการรวบรวมขอมูลทางดานเทคนิคการตัดตอเสียง และการใชเอฟเฟคสําหรับ
เสียง เพื่อนําไปใชประกอบกับสื่อผสมประเภทวิดีโอ จากนั้นจึงนําขอมูลที่ไดมาวิเคราะหและสรุปใจความสําคัญในรูปแบบการ
พรรณนาพรอมภาพอธิบายประกอบ 
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แนวคิดที่เกี่ยวของ 
โปรแกรม Nuendo 
 Nuendo ถูกคิดคนและผลิตโดยบริษัท Steinberg media Technologies เปนบริษัทผูผลิตซอฟตแวรเพื่อการทํางาน
ทางดานเสียงและดนตรี การทํางานดานเสียงวิดีโอและภาพยนตรขั้นสูงมาตั้งแตป ค.ศ. 1984 จนมาถึงปจจุบัน Steinberg ไดเปน
หนึ่งในผูผลิตซอฟตแวรและฮารดแวรสําหรับเพลงและเสียงที่ใหญที่สุดในโลกโดยมีผูใชงานหลายลานคนทั่วโลก  ซึ่งกลุมผลิตภัณฑ
จาก Steinberg ก็ไดรับการยอมรับมาอยางยาวนานในการทํางานดานเสียงในระบบดิจิทัลสมัยใหม ทําใหถือไดวาบริษัท Steinberg 
นั้นเปนกระดูกสันหลังในการอํานวยความสะดวกใหแกผูเชี่ยวชาญในสายงานดานการแตงเพลงและผลิตผลงานทางดานเสียง การ
ออกแบบเสียง รวมถึงการทําเสียงประกอบภาพยนตร และในป ค.ศ. 2000 Steinberg ไดทําการเผยแพรโปรแกรม Nuendo ขึ้น
เปนครั้งแรก ซึ่งเปนการบุกตลาดซอฟตแวรการที่เปนเวิรคสเตชั่นในระดับมืออาชีพ ดวยการนําเสนอการทํางานใหมๆ มีจุดเดนเรื่อง
ความยืดหยุนในการใชงาน ซึ่งรวมไปถึงความสามารถในการทํางานในระบบเสียงรอบทิศทาง 
 Nuendo 10 นับไดวาเปนอีกกาวหนึ่งที่เปนกาวกระโดดสําหรับแพลตฟอรมการทํางานในระบบเสียงหลังจากที่อยูใน
ระดับแนวหนาของอุตสาหกรรมมาเกือบ 20 ป โดยเริ่มแรก Nuendo ไดถูกสรางมาเพื่อการทํางานทางดานเสียง โดยมีขอบเขตการ
ทํางานผานนวัตกรรมใหมๆที่ล้ําสมัยปลั๊กอิน(Plug-in) ที่ดีที่สุดและรองรับเทคโนโลยีและรูปแบบลาสุด ซึ่ง Nuendo ถูกขับเคลื่อน
โดยผูใชและผูที่อยูแถวหนาของอุตสาหกรรมเสียงที่มีการเปลี่ยนแปลงอยางรวดเร็วในชวงหลายปที่ผานมา มีการอัพเดตและการ
ปรับปรุงอยางสม่ําเสมอทําใหมั่นใจไดวา Nuendo ยังคงเปนผูนําในตลาด โดยการเพิ่มคุณสมบัติใหมๆ มีการปรับปรุงอยูเสนอ ทําให
สรางความมั่นใจวาจะมอบคุณภาพเสียงที่ยอดเยี่ยมได และมั่นใจไดวา Nuendo ยังคงเปนแพลตฟอรมระดับสูงสําหรับมืออาชีพที่
ตองการนําเสนอเสียงที่ดีที่สุด นอกจากน้ี Nuendo ยังไดรับการพัฒนาโดยทีมผูเชี่ยวชาญดานเสียงโดยเฉพาะ ซึ่งทีมงานนี้มีทักษะ
และประสบการณที่จะทําใหผูใชงานไดใชเครื่องมือที่ดีที่สุดและมีประสิทธิภาพเพียงปลายนิ้วสัมผัส ซึ่งทีมงานนักวางแผนผลิตภัณฑ
นั้นมีความเปนมืออาชีพดวยประสบการณและมีความใกลชิดกับอุตสาหกรรมเสียงพรอมทั้งยังมีการมองหาแนวโนมในการพัฒนา
ตอไป นอกจากนี้นักวางแผนและนักพัฒนาซอฟตแวรยังทํางานรวมกับผูใช Nuendo โดยมีการใหลองใชคุณสมบัติใหมๆ และให
ขอมูลเพื่อใหแนใจวาคุณสมบัติใหมๆทั้งหมดจะไดรับการปรับใชตามที่ผูใชงานตองการ(Steinberg: ออนไลน) 
 

การตั้งคาอุปกรณแปลงสัญญาณเสียง(Audio Interface) ใน Nuendo 
 โปรแกรม Nuendo เปนโปรแกรมที่สามารถทํางานทางดานเสียงที่มีระดับมืออาชีพ ซึ่งโปรแกรม Nuendo นั้นก็สามารถ
ที่จะใชงานรวมกับอุปกรณเชื่อมตอภายนอกที่เรียกวาออดิโอ อินเทอรเฟซ(Audio interface) ไดอยางอยากหลาย ซึ่งออดิโอ 
อินเทอรเฟซนั้นเปนอุปกรณที่ใชในการแปลงสัญญาณจากระบบอนาล็อก(Analog)สูสัญญาณดิจิทัล(Digital) เพื่อใหคอมพิวเตอร
สามารถอานและประมวลผลเสียงไดโดยแบงออกเปนการแปลงสัญญาณ 2 ขั้นตอนคือ 1.สัญญาณขาเขา(Input) แปลงสัญญาณ
อนาล็อก(Analog) สูสัญญาณดิจิตอล(Digital) 2. สัญญาณขาออก แปลงสัญญาณดิจิตอล(Digital)สูอนาล็อก(Analog) ซึ่งการใชงาน
ระหวางออดิโอ อินเทอรเฟส(Audio interface)และ Nuendo รวมกันน้ันตองมีการตั้งคาในโปรแกรม Nuendo ดังนี ้

1. เมื่อเขามาที่หนาโปรเจคแลวใหเลือกที่เมนู Studio และเลือก Studio setup หลังจากน้ันใหคลิกไปที่ VST Audio  
System 
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         ภาพที่ 1 การตั้งคา Studio setup             ภาพที่ 2 VST Audio system 
                   ที่มา : ณัฐ เชียงทอง                                                          ที่มา : ณัฐ เชียงทอง 
 
2. ทําการเลือกไดรเวอรของ Audio interface ที่ตองการใช ในเมนู ASIO Driver ในกรณีตัวอยางนี้เลือกที่ Focusrite 

USB ASIO หลังจากนั้นจะมีหนาตางใหยืนยันการเลือกโดยหากยืนยันใหคลิกที่คําสั่ง Switch 

 
 

 
 
 
 
 
 
 
 
 

 
      ภาพที่ 3 การเลือก ASIO Driver      ภาพที่ 4 คลิกเลือก Switch 
          ที่มา : ณัฐ เชียงทอง                                ที่มา : ณัฐ เชียงทอง 

 
การใชออดิโออินเทอรเฟซ(Audio Interface) ในการทํางานจะชวยใหคุณภาพเสียงของงานนั้นดีขึ้น การทํางานที่แมนยํา

และรวดเร็วมากกวาซาวดการด(Sound Card)ที่ติดมากับคอมพิวเตอร ซึ่ง Ben Harris(2009) กลาววาซาวดการดเปนอุปกรณที่ทํา
ใหคอมพิวเตอรสามารถทํางานทางดานเสียงไดทั้งเรื่องของการบันทึกเสียงและการเลนเสียงออกจากคอมพิวเตอร ซึ่งคอมพิวเตอร
ทุกเครื่องจะมีซาวดการดมาใหเปนปกติแตสวนใหญแลวคุณภาพจะไมเพียงพอในการทํางาน ซึ่งเปนที่มาของประโยคที่วากฎของการ
ทํางานทางดานเสียงคือ Audio Interface ไมใชซาวดการด 

 
การนําเขาวิดีโอ 
 โปรแกรม Nuendo นั้นเปนโปรแกรมที่สามารถนําวิดีโอเขามาเพื่อทําการจัดเรียงเสียงประกอบไดโดยขอที่ควรคํานึงหาก
ตองการนําไฟลวิดีโอเขามาคือการตั้งคาเฟรมเรท(Frame Rate) ใหตรงกับวิดีโอที่นําเขามาเนื่องจากจะทําใหการเลนวิดีโอน้ันมีการ
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เคลื่อนที่ที่ตรงและถูกตองตามตนฉบับจริง เนื่องจากคาของเฟรมเรทนั้นมีผลเกี่ยวกับเวลาในการเคลื่อนที่ของวิดีโอนั้น ตามที่ 
Underdahl(2003) ไดกลาววาอัตราเฟรมเรทของวิดีโอคือจํานวนภาพแตละภาพที่ปรากฏอยูในเวลา 1 วินาที จึงทําใหดูเหมือนมี
การเคลื่อนไหว ซึ่งตัวยอของเฟรมเรทนั้นจะถูกเขียนไววา fps(Frame per second) และในโปรแกรม Nuendo ก็สามารถนําเขา
วิดีโอปรับเปลี่ยนคาเฟรมเรทไดดวยวิธีการดังนี้ 

1.การนําเขาวิดีโอสามารถทําไดดวยการไปเลือกที่เมนู File>Import>Video file และเลือกไฟลวิดีโอที่ตองการ 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

     ภาพที่ 5 การ Import Video 
         ที่มา : ณัฐ เชียงทอง 
 

 2. เมื่อเลือกไฟลวิดีโอแลวก็จะมีแทรควิดีโอและเสียงที่มาจากวิดีโอตนฉบับมาดวย หากตองการแสดงวิดีโอนี้ใหคลิกที่ 
Reveal Video Window ก็จะปรากฏหนาตางของการเลนวิดีโอขึ้น ซึ้งจากภาพดานลางนี้จะเห็นไดวามีขอความฟองวาโปรเจคนี้มี
คาเฟรมเรทที่ไมตรงกับวิดีโอที่นําเขามาจึงตองทําการตั้งคาใหตรงกันตามขั้นตอนตอไป 
 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพที่ 6 รูปแสดงวิดีโอที่นําเขามาแลว 
          ที่มา : ณัฐ เชียงทอง 
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 3. การตั้งคาวิดีโอเฟรมเรทใหไปที่ Project > Project Setup 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

ภาพที่ 7 การเลือกเมนู Project Setup 
            ที่มา : ณัฐ เชียงทอง 
 

 4. หลังจากนั้นจะมีหนาตาง Project Setup ขึ้นมาโดยสามารถตั้งคาเฟรมเรทไดที่เมนู Project Frame Rate 
หากไมรูคาเฟรมเรทของวิดีโอน้ีสามารถคลิกที่ Get Frame Rate from Video ไดเนื่องจากโปรแกรมจะตั้งคาใหอัตโนมัติ เสร็
ตเรียบรอยแลวคลิก OK 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 8 การตั้งคาProject Frame Rate 
            ที่มา : ณัฐ เชียงทอง 
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 5. หลังจากตั้งคาเฟรมเรทเรียบรอยแลวจะเห็นไดวาขอความที่ฟองวาเฟรมเรทของโปรเจคและวิดีโอไมตรงกันน้ัน
หายไปเนื่องจากถูกตั้งใหคาเฟรมเรทตรงกันแลว 
 
 
 
 
 

 

 

 

 

 

 

 

 

ภาพที่ 9 ขอความที่ฟองวาเฟรมเรทของโปรเจคและวิดีโอไมตรงกันนั้นหายไป 
ที่มา : ณัฐ เชียงทอง 

 

การนําเสียงเขาและการตัดตอเสียง 
 ในการจัดวางและตัดตอเสียงนั้นโปรแกรมประเภท DAW(Digital Audio Workstation) จะปรากฏเสียงในลักษณะของ

คลื่นเสียง(Wave form) เปนมาตรฐาน ซึ่งโปรแกรม Nuendo ก็แสดงผลตามมาตรฐานนี้เชนกัน ในหลายๆครั้งที่เราอาจจะเคยได

ยินเสียงจากส่ือชองทางตางๆแลวรูสึกวาเสียงที่ไดยินนั้นมีความไมตอเนื่องบาง สะดุดบาง เปนสาเหตุมาจากการจัดวางและตัดตอ

เสียงที่ไมดีพอทําใหเสียงที่ไดเกิดความไมตอเนื่อง ดังนั้นเมื่อเราตองการจะแกไขการจัดวางหรือตัดตอคลื่นเสียงตองมีการทําใหคลื่น

เสียงที่มาบรรจบกันนั้นประสานกันไดอยางดี ตามขั้นตอนดังนี ้

 1.  การนําเขาเสียงสามารถทําไดดวยการไปเลือกที่เมนู File>Import>Audio file 

 

 

 

 

 

 

 

 

 
 
 
 

ภาพที่ 10 การ Import Audio File 
            ที่มา : ณัฐ เชียงทอง 
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 2. จากนั้นโปรแกรมจะขึ้นหนาตาง Import Option เพื่อถามวาจะคัดลอกไฟลเสียงนี้ไปไวในโฟลเดอรของโปรเจยหรือไม 

และจะทําการแปลงคา Sample rate และ Bit dept หรือไม ใหทําการเลือกเพื่อคัดลอกและทําการแปลงสัญญาณ และคลิก OK 

 

 

 

 

 

 

 

 

 

ภาพที่ 11 หนาตาง Import Option 
ที่มา : ณัฐ เชียงทอง 

 
 3. ในการจัดวางและตัดตอเสียงนั้นควรจะปดฟงกชัน Snap เพื่อใหสามารถตัดและเลื่อนตําแหนงของคลื่นไดอยางอิสระ 

และยังสามารถเคลื่อนยายไดอยางละเอียดในกรณีที่ทํางานรวมกับภาพ 

 

 

 

 

 

 

 

 

ภาพที่ 12 การเปดปดคําสั่ง Snap 
ที่มา : ณัฐ เชียงทอง 

 
 4. ใชกรรไกรตัดในจุดที่ตองการ 
 
 
 
 
 
 

 
ภาพที่ 13 เลือกกรรไกรเพื่อตัดเสียง 

ที่มา : ณัฐ เชียงทอง 
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 5. กลับมาเลือกที่ลูกศรจึงสามารถทําการเลื่อนคลื่นเสียงได 
 
 
 
 
 
 
 

 
ภาพที่ 14 เลือกลูกศรเพื่อทําการเลื่อนคลื่นเสียง 

ที่มา : ณัฐ เชียงทอง 
 

 6. เมื่อเราเลื่อนคลื่นเสียงมาจะเห็นไดวาคลื่นเสียงจะมีสวนที่ทับกันทําใหเสียงที่ไดเกิดการสะดุด 
 
 
 
 
 

 
ภาพที่ 15 รูปแสดงเมื่อเลื่อนคลื่นเสียงมาทับกัน 

ที่มา : ณัฐ เชียงทอง 
 

 7. ทําการกดปุม X ที่คียบอรดคอมพิวเตอรเพื่อใหคลื่นเสียงทั้งสองเกิดการครอสเฟด(Cross fade)กัน จะทําใหเสียงทั้ง
สองทําการประสานการอยางเขากันมากขึ้นไมสะดุด 

 
 
 
 
 
 

ภาพที่ 16 รูปแสดงเมื่อเลื่อนคลื่นเสียงเกิดการครอสเฟด 
ที่มา : ณัฐ เชียงทอง 

 ในการเลื่อนและการจัดวางคลื่นเสียงตางๆสามารถทําไดจากขั้นตอนตอไปนี้ แตการจัดวางเสียงนั้นไมสามารถ
สังเกตไดดวยตาเทานั้น การจัดวางจําเปนอยางมากที่ตองใชหูในการฟงและวิเคราะหหาจุดที่เหมาะสม ดังนั้นผูใชควรมีการฝกฝนใน
การฟงดวยจึงจะสามารถจัดวางไดอยางดี Simon Langford(2014) กลาววา จุดประสงคของการทําครอสเฟดคือการทําใหเสียงซึ่ง
มาจากคนละคลื่นใหมีการเชื่อมตอกันอยางตอเนื่อง การทํา ครอสเฟดอาจเกิดไดจากสองกรณี คือ 1. เมื่อตองการนําเสียงทั้งสอง
เสียงที่ไมไดมีความเกี่ยวของกันนํามาตอกัน 2. เมื่อเสียงทั้งสองที่มีความใกลเคียงกันนํามาเชื่อมตอเพื่อใหมีความตอเน่ืองกัน 
 
การแกไขและการผสมเสียง 
 การสรางผลงานเพลงขึ้นมาเพื่อเผยแพรนั้นจะตองผานกระบวนการบันทึกเสียงทั้งนั้น ไมวาจะเปนการบันทึกเสียง
รอง หรือเครื่องดนตรีตางๆ แมกระทั่งการบันทึกเสียงบรรยากาศตางๆรอบตัวเรา ก็ผานขั้นตอนการประมวลผลในการบันทึกเสียงทั้ง
แบบอนาล็อก (Analog Recording) และดิจิตอล (Digital Recording) และหลังจากกระบวนการบันทึกเสียงแลวเสียงที่ถูกบันทึกไว
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จะตองนํามาตัดตอตกแตงใหไพเราะและเหมาะสมกันระหวางเครื่องดนตรีแตละชิ้น ซึ่งในการะบวนการนี้วิศวกรทางดานเสียงจะ
เรียกวาขั้นตอนของการมิกซซิ่ง(Mixing) โดยในขั้นตอนของการมิกซซิ่งนี้จะเปนขั้นตอนของการตัดตอตกแตงเสียงใหดีมากยิ่งขึ้น 
ผานการจัดการดานความดังของเสียง ตําแหนงของเสียง รวมถึงการในเอฟเฟคตางๆ ไมวาจะเปน รีเวิรบ(Reverb) หรือ ดีเลย
(Delay) Bobby Owsinski(2006) ไดกลาวไววาโดยสวนใหญแลววิศวกรเสียงนั้นจะมีเสียงและจินตนาการของเสียงที่มีอยูในหัว
กอนที่จะเริ่มงาน ซึ่งอาจจะเกิดจากการทํางานที่ไมละเอียดแลวคอยๆเริ่มปรับแตงใหดีขึ้นเรื่อยๆ ถาเมื่อใดที่วิศวกรเสียงไดรับการ
มอบหมายการมิกซเพลงขึ้นมา บางทีพวกเขาจะไมเริ่มทํางานทันทีหากเขาไมมีแนวทางในการทํางาน 
 
เอฟเฟคในการผสมเสียง 
 ในการใชเอฟเฟคเพื่อตกแตงเสียงหรือผสมเสียงเพื่อใหไดคุณภาพ หรือการจําลองเสียงตามที่ผูใชตองการแกไขให
เสียงที่ไดนั้นมีความชัดเจนหรือสมจริง สามารถแสดงออกมารวมกับภาพไดอยางสอดคลอง ซึ่งการใชเอฟเฟคอาจอยูในรูปแบบที่เปน
อุปกรณประเภทฮารดแวรหรือปลั๊กอิน(Plug-ins) ก็สามารถใชในการตกแต งเสียงได เชนกันดังที่  Hilary Wyatt & Tim 
Amyes(2005) กลาววา ปลั๊กอินเปนซอฟแวรที่ทําการจําลองมาจากอุปกรณที่เปนเอฟเฟคประเภทฮารดแวร และมีการจําลองทั้ง
ลักษณะของเสียงรวมถึงรูปรางหนาตาของฮารดแวร ซึ่งสามารถทําการเพิ่มเขาไปในเสียงที่ตองการ ปลั๊กอินนั้นก็มีขอเสียอยู
เหมือนกันคือ ปลั๊กอินแตละปลั๊กอินอาจมีคุณภาพที่แตกตางกันไปและทุกครั้งที่มีการเปดใชก็จะมีการใชพลังงานในการประมวลผล
จากคอมพิวเตอรดวย 
 

คอมเพรสเซอร(Compressor) 
 Mike Senior(2011:146) กลาววาคอมเพรสเซอร(Compressor) เปนเอฟเฟคที่มีลักษณะคลายกับการที่มีเฟดเดอร
(Fader) ที่จัดการกับเสียงที่มีลักษณะความแรงของสัญญาณที่หลากหลายและมีความแปรปรวนไดอยางอัตโนมัติ อาจแปลไดวาเรา
สามารถจัดการกับความแปรปรวนของสัญญาณที่ไมพึงประสงคใหมีระดับความดังของสัญญาณที่สมดุลไดโดยการใชคอมเพรสเซอร
นั่นเอง 
 David Miles Huber & Robert E. Runstein (2010:492) กลาวไววา เอเฟคคอมเพรสเซอรนั้นเปนเหมือนกับการที่เรา
ใชเฟดเดอรในการปรับระดับความดังของเสียงไดโดยอัตโนมัติ โดยใชในการลดชวงความตางของความดังของคลื่นเสียง หรือการลด
ระดับความดังของเสียงตามที่ผูใชงานไดกําหนดเอาไววาไมใหเกินระดับความดังที่เทาไหร ในขณะเดียวกันเมื่อมีการลดสัญญาณที่มี
ความดังเกินที่ตองการแลว ก็ยังสามารถเพิ่มสัญญาณของเสียงใหดังขึ้นไดโดยที่สัญญาณไมเกินคามาตรฐานโดยใชการทํางานรวมกับ
ฟงกช่ันซอฟเลเวล(soft levels) ซึ่งโดยปกติแลวเอฟเฟคคอมเพรสเซอรนั้นจะประกอบไปดวยการควบคุมคาตางๆดังนี้ 
       Input gain หมายถึง การดังระดับสัญญาณของเสียงวาจะปลอยใหความดังที่เขามาในเอฟเฟคคอมเพรสเซอรนั้นเขามา
เทาไหร 
        Threshold หมายถึง การตั้งคาระดับความดังของสัญญาณวาระดับเทาไหรที่จะใหคอมเพรสเซอรเริ่มทํางาน ยกตัวอยาง
เชน ถาตั้งคา threshold ไวที่ -20dB สัญญาณที่อยูในระดับที่ต่ํากวา -20dB ลงมาก็จะไมมีผลกับการคอมเพรสในครั้งนี้ แตเมื่อไหร
ที่มีคาความดังเกิน -20dB ก็จะถูกคอมเพรสเซอรกดระดับความดังของสัญญาณลงมา 
          Output gain หมายถึง การตั้งคาความดังสัญญาณขาออก สามารถทั้งเพิ่มสัญญาณหรือลดระดับความตางสัญญาณความ

ดังของเสียงได 

 Slope ratio หมายถึง การตั้งคาการกดสัญญาณจากสัญญาณขาเขาไปสูสัญญาณขาออก โดยมีการตั้งอัตราสวนตางๆใน
การควบคุม ยกตัวอยางเชนหากตั้งคา ratio อยูที่ 4:1 หมายความวาทุกๆความดังเกินเกินคาที่ตั้งไวจาก threshold จะถูกลด
สัญญาณลง 1dB และถาหากสัญญาณเกินมาที่ 8dB เทากับวาจะถูกกดลงไป 2dB 
 Attack หมายถึง การตั้งควาความไวของคอมเพรสเซอรวาเมื่อมีสัญญาณเกินมาน้ันใหเอฟเฟคเริ่มทํางานที่เวลาเทาไหร 
โดยมีคาของเวลาในหนวยมิลลิวินาที(Millisecond) ทั้งนี้การปรับความไวของ attack นั้นก็ขึ้นอยูกับเสียงของชนิดเครื่องดนตรีดวย
วาคือเครื่องดนตรีชิ้นไหน อยางเชนเสียงเบสน้ันตองความความยาวของหางเสียงก็ควรที่จะตั้งคาการทํางานใหชา เพื่อที่จะไดเสียงใน
ระดับความดังที่ดี 
         Release หมายถึง การตั้งคาความเร็วในการปลอยการกดของสัญญาณใหกลับมาสูระดับปกติ โดยมีหนวยเปนเวลา
เหมือนกับการตั้งคา attack คือมิลลิวินาที(Millisecond) หากตั้งคาไวเร็วก็อาจจะทําใหระดับความดังของเสียงนั้นเปลี่ยนเร็วเกินไป 
ในขณะเดียวกันหากตั้งคาไวชาก็จะสงผลกับเสียงที่มีชวงหางจากดังไปเบา 
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         Meter display หมายถึง การควบคุมหนาจอมาตรวัดสัญญาณใหเปนสัญญาณขาออกหรือเปนในสวนของการกดสัญญาณ

ความดัง 

 

   
 
 
 
 
 

ภาพที่ 17 รูปแสดงการเปรียบเทียบของคลื่นเสียงเมื่อใชเอฟเฟคคอมเพรสเซอร 
        ที่มา : ณัฐ เชียงทอง 

  
 จากรูปที่ 17 สังเกตเห็นไดวาความสูงของคลื่นเสียงดานลางไดมีการผานเอฟเฟคคอมเพรสเซอรแลวจึงมีความสมดุลและ
ใกลเคียงกันมากขึ้นกวาคลื่นเสียงที่ยังไมไดผานคอมเพรสเซอร 
 สิ่งแรกที่ควรจะตัดสินใจในการใชคอมเพรสเซอรในแตละแทรคนั้นตองเกิดจากความจําเปนจริงๆ  และควรจําไววา
วัตถุประสงคของการใชคอมเพรสเซอรคือการจัดการความสมดุลที่ดีของเสียงในแตละเครื่องดนตรี และเมื่อไรก็ตามที่เราไมสามารถ
หาสมดุลของเสียงไดเราจึงเปนการนําพาไปสูกระบวนการปรับแตงเพิ่มเติม อาจมีเหตุผลมากมายที่รูสึกถึงความไมสมดุลของเสียง 
แตก็สามารถแกไขปญหาเหลานี้ไดจากการใชคอมเพรสเซอร ยกตัวอยางเชนเสียงรองจะทําเปนอยางแรก เราตองทําใหความดังของ
เสียงทั้งแทรคนั้นสมดุลกันทั้งหมด หากประโยคหรือคําที่เจอนั้นมีความไมชัดเจนจึงใชคอมเพรสเซอรในการจัดการ เพราะ
คอมเพรสเซอรจะชวยลดความแตกตางของสัญญาณความดังของเสียงได สงผลใหเสียงมีความชัดเจนในแตละคํามากขึ้น(Mike 
Senior: 2011) 
 
รีเวิรบ(Reverb) 
 Mike Senior(2011) ไดกลาวไววา ในวงการดนตรีไดใชคําวาเสียงหวานกันอยางแพรหลายในการผลิตหรือบันทึกเสียงงาน
ดนตรีขึ้นมานั้นไดเกิดมาจากการที่เสียงนั้นมีการปรุงแตงโดยรีเวิรบ(reverb) เพื่อเปนการจําลองสถานการณหรือสถานที่ตางๆที่
ตองการ แตอยางไรก็ตามในปจจุบันรีเวิรบนั้นมิไดใชกันเพื่อจําลองสถานที่มากเทาไหร แตจะมุงเนนไปในทางสรางสรรคลักษณะของ
เสียงใหมีความแปลกใหม 
 คุณสมบัติ 5 ประการของรีเวิรบ 
 1. การผสมผสานใหเสียง การเกิดรีเวิรบนั้นสามารถทําใหเสียงของแทรคแตละแทรคนั้นผสมผสานเชื่อมตอกันได ทําให
เครื่องดนตรีแตละชิ้น หรือวาการตัดตอที่เสียงขาดกันนั้นเชื่อมตอผสมกันไดอยางกลมกลืน นอกจากน้ียังสามารถสรางลักษณะมิติ
ของเสียงใหโดดเดนอยูดานหนาหรือเปนเพียงเสียงบรรยากาศประกอบดานหลังได 
 2. สามารถจําลองขนาดสถานที่ รีเวิรบสามารถจําลองและกําหนดขนาดของหองที่บันทึกเสียงได ราวกับเสียงที่บันทึกน้ัน
ไดผานการบันทึกมาจากสถานที่นั้นจริงๆ 
 3. โทนและสีสันของเสียง รีเวิรบสามารถทําใหเสียงที่อยูในขั้นตอนการมิกซนั้นไมเกิดการหักลางกันได และอาจเปลี่ยน
โทนของเสียงที่ไมสมํ่าเสมอใหสามารถกลมกลืนและดีขึ้นได 
 4. การเพิ่มหางเสียง เนื่องจากรีเวิรบเปนเอฟเฟคที่เกี่ยวของกับการสะทอนของเสียงและทําใหเกิดเสียงกอง ดังนั้นเสียงที่
ยังไมผานการปรับแตงใดๆเมื่อผานการใชรีเวิรบจะมีผลที่ไดคือหางเสียงของเสียงนั้นๆก็จะยาวขึ้น แตอยางไรก็ตามหางเสียงนั้นไมได
มีความสม่ําเสมอกันในทุกๆความถี่ เพราะฉะนั้นจึงขึ้นอยูกับการปรับแตงการสะทอนในแตละความถี่ดวย 
 5. การกระจายของเสียง การจําลองเสียงสะทอนน้ันถูกสรางและจําลองมิติของเสียงออกมาผานการใชเอฟเฟครีเวิรบ และ
ยังสามารถทําใหเกิดมิติที่เปนแบบสเตอริโอได 
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 การตั้งคาฟงกชันมาตรฐานใน Reverb 
 1. Pre-Delay เปนการกําหนดเวลาใหเสียงเริ่มสะทอนเมื่อใด ชวยใหสามารถจําลองหองขนาดใหญได โดยการเพิ่มเวลาที่
ใชสําหรับการสะทอนครั้งแรกที่จะไปถึงผูฟง 
 2. Reverb time การตั้งคาเวลาความยาวของเสียงสะทอน 
 3. Diffusion การตั้งคาการฟุงกระจายของเอฟเฟค 
 4. Lo level การตั้งคาความดังของเสียงสะทอนในยานความถี่ต่ํา 
 5. Hi level การตั้งคาความดังของเสียงสะทอนในยานความถี่สูง  
 6. Mix เปนการตั้งคาความสมดุลระหวางเสียงจริงและเสียงที่ผานเอฟเฟคแลว 
 
การเลือกใชงานเอฟเฟคในโปรแกรม Nuendo 
 ในการปรับแตงดวยการใช Edit Channel Setting นี้เปนวิธีที่ลดความผิดพลาดจากการตกแตงไดดีเนื่องจากการใชวิธีการ 
Edit Channel Setting นี้เราสามารถแกไขการปรับแตงเสียงไดตลอดเวลาที่ตองการจนกวาจะจบงาน โดยกระบวนการวิธีดังน้ี 
 1. เมื่อเรามีเสียงหรือเวฟที่ตองการจะปรับแตงแลวใหทําการคลิกที่ Edit Channel Setting ตามวงกลมที่ปรากฏอยูบนรูป 

 
 
 
 

ภาพที่ 18 เลือก Edit Channel Setting  
ที่มา : ณัฐ เชียงทอง 

 
 2. เมื่อคลิก Edit Channel Setting แลวจะขึ้นหนาตางนี้ขึ้นมา  ใหคลิกที่ตาราง insert เอฟเฟคขึ้นมา เพื่อเลือกใชเอฟ
เฟคที่ตองการ โดยจะทําการยกตัวอยาง Reverb ช่ือ Room works  

 
 
 
 
 
 
 
 
 
 

ภาพที่ 19 เลือก Reverb ชื่อ Room works 
ที่มา : ณัฐ เชียงทอง 
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 4. เมื่อเอฟเฟค Room works ขึ้นมา เราสามารถปรับแตงเองไดตามที่ชอบ หรือสามารถเลือกใช preset ก็ได เมื่อทําการ
ปรับแตงเสร็จเรียบรอยแลวใหทําการปดหนาตาง Edit Channel Setting นี้ไดเลย 

 
 
 
 
 
 
 
 

ภาพที่ 20 หนาตางเอฟเฟค Reverb ชื่อ Room works 
ที่มา : ณัฐ เชียงทอง 

 
  5. ในกรณีที่เรายังไมพอใจการปรับแตง และตองการแกไขใหมสามารถยอนทําไดตามกระบวนการขั้นตอนแรก และเมื่อ
เขามาที่หนาตาง Edit Channel Setting แลว เราจะเห็นวามี Plug-ins ที่เลือกใชอยูแลวคือ Room works ขั้นตอนนี้เราสามารถ
ดับเบิลคลิกที่ plug-ins Room works และปรับแตงแกไขซ้ําไดเลย เมื่อปรับแตงเสร็จเรียบรอยแลวก็สามารถปดหนาตางน้ีลงไดเลย 

 
 
 
 
 
  
 

 
 

       ภาพที่ 21 เมนู Insert แสดงเอฟเฟคที่เลือกใช Reverb ช่ือ Room works 
                 ที่มา : ณัฐ เชียงทอง 
 
 การใชเอฟเฟคใน Edit Channel Setting นั้นสามารถเรียกใชงานเอฟเฟคไดหลากหลายชนิดและยังสามารถใช

งานเอฟเฟคหลายๆอยางพรอมกันไดดวย โดยการเรียงลําดับจากชอง Insert(Steinberg, 2020 
 

การ Export วิดีโอจาก Nuendo 
 Nuendo นั้นสามารถทําการตัดตอและทําการ Export ไฟลในรูปแบบวิดีโอไดดวย ซึ่งจะแตกตางจากโปรแกรม 

Cubase ที่มาจากบริษัทเดียวกัน หนาตาเหมือนกัน แตทางดาน Cubase นั้นจะไมสามารถตัดวิดีโอและ export วิดีโอได แต
อยางไรก็ตามแมวา Nuendo จะสามารถตัดวิดีโอไดแตก็ไมสามารถปรับแตงสิ่งที่เกี่ยวกับวิดีโอไดเลย โดยการ Export วิดีโอจาก 
Nuendo ทําไดดังนี้ 
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1. ทําการตั้ง Locator จุดเริ่มและจุดสิ้นสุดที่ตองการ Export และคลิกที่ File> Export> Video 
  
 
 
 
 
 
 
 
 

 
 
 

          ภาพที่ 22 การ Export วิดีโอ 
               ที่มา : ณัฐ เชียงทอง 
 

 3. เมื่อเลือก Export Video แลวจะไดหนาตางขึ้นมา เมื่อตั้งชื่อและคาตางๆแลวคลิกที่ Export Videoไดเลย เทาน้ีเสียงก็
จะถูกนําออกไปไวในที่ที่ถูกจัดเก็บ 

 
 
 
 
 
 
 
 
 
 
 
 

     ภาพที่ 23 หนาตางการ Export วิดีโอ 
      ที่มา : ณัฐ เชียงทอง 
 

 เมนูสําคัญตางๆที่ตองทําการตั้งคา Export วิดีโอ 
 File Name   หมายถึง การตั้งชื่อไฟลวิดีโอที่ตองการ Export 
 File Path  หมายถึง การเลือกโฟลเดอรจัดเก็บไฟลวิดีโอที่ตองการ Export 
 File Format  หมายถึง การแสดงนามสกุลของไฟลวิดีโอที่ตองการ Export 
 Channels selection หมายถึง การตั้งคา output ที่ตองการนําเสียงออก  
 โปรแกรม Nuendo นั้นจะมีความสามารถในการ Export วิดีโอไดแตก็มีขอจํากัดดวยเชนกัน คือสามารถ export ใน
รูปแบบของไฟลนามสกุล .mp4 codec H.264 สวนทางดานเสียงจะไดความละเอียดที่ 16 bits 44.1 kHz และ 16bits 48 kHz 



วารสารศิลปปริทัศน คณะศิลปกรรมศาสตร 

 มหาวิทยาลัยราชภัฏสวนสุนันทา ปท่ี 9 ฉบับที่ 2 พ.ศ.2564 

 

 
36 

 

ขนาดภาพที่ 1920 x 1080 px (Full HD) เทานั้น หากไฟลวิดีโอที่นําเขามามีขนาดที่เล็กหรือใหญกวานี้จะถูกปรับใหเปนขนาด 
1920 x 1080 px (Full HD) เชนกัน(Steinberg, 2020) 
 

สรุป 
 เนื่องจากการจัดทําสื่อในยุคปจจุบันนั้นเปนการทํางานในระบบดิจิทัล ซึ่งคอมพิวเตอรและอุปกรณเชื่อมตอตางๆนั้นลวน
แลวมีบทบาทสําคัญในการทํางาน การทํางานทางดานเสียงนั้นหากจะทําใหไดมีประสิทธิภาพดีก็ควรจะตองมีอุปกรณการ
ประมวลผลทางดานเสียงที่ดีดวย และอุปกรณนั้นก็คือ Audio Interface ซึ่งเปนอุปกรณที่ทําหนาที่ในดานเสียงโดยตรง สามารถทํา
ใหการแสดงผลทางดานเสียงนั้นมีความแมนยํา ถูกตองและมีคุณภาพที่ดีกวาการใชซาวดการด(Sound card) จากคอมพิวเตอร 
นอกจากนี้ Audio Interface ยังสามารถนํามาใชกับโปรแกรม Nuendo ได ซึ่งโปรแกรม Nuendo เปนโปรแกรมที่คิดคนและผลิต
โดยบริษัท Steinberg media Technologies ซึ่ง Nuendo เปนโปรแกรมที่สามารถทํางานทางดานเสียงในระดับมืออาชีพ ไมวาจะ
เปนงานบันทึกเสียง งานตัดตอและตกแตงเสียง ซึ่งผูใชสามารถใชโปรแกรม Nuendo มาสรางงานเสียงประกอบภาพยนตร งาน
เสียงประกอบโฆษณา รวมถึงงานทางดานดนตรี หรือเสียงประกอบสื่อตางๆไดเปนอยางดี  
 หลักสําคัญในการสรางเสียงประกอบสื่อใหดีและมีคุณภาพที่สามารถนําไปเผยแพรและใชงานไดจริงตองอาศัยการตัดตอ
และผสมเสียงที่ดีดวย โดยการตัดตอเสียงนั้นตองมีการคํานึงถึงความตอเนื่องของเสียงที่นํามาวางตอกัน โดยอาจทําใหเสียงเลนได
อยางตอเนื่องกันไดดวยการทําครอสเฟด(Cross Fade) แตการจัดวางเสียงใหตอกันดวยวิธีการทําครอสเฟดก็ไมสามารถสังเกตได
ดวยตาเทานั้น การจัดวางจําเปนอยางมากที่ตองใชหูในการฟงและวิเคราะหหาจุดที่เหมาะสม การใชเอฟเฟครีเวิรบ(Reverb) ก็
สามารถชวยทําใหหางเสียงมีความยาวมากขึ้น เนื่องจากการเกิดรีเวิรบสามารถทําใหเสียงของแทรคแตละแทรคนั้นผสมผสาน
เชื่อมตอกันได ทําใหเครื่องดนตรีแตละชิ้น หรือวาการตัดตอที่เสียงขาดกันนั้นเชื่อมตอผสมกันไดอยางกลมกลืนเปนอยางดี และใน
สวนของความดังควรจะมีความดังที่สมดุลกันเปนอยางดีรวมถึงไมดังเกินไป โดยการใชเอฟเฟคคอมเพรสเซอร(Compressor) เขามา
ชวยในการทํางาน เนื่องจากเอฟเฟคคอมเพรสเซอรนั้นเปรียบเสมือนการใชเฟดเดอรแบบอัตโนมัติเพื่อจัดการกับความแปรปรวน
ของสัญญาณที่ไมพึงประสงคใหมีระดับความดังของสัญญาณที่สมดุลไดเปนอยางดี นอกจากนี้ Nuendo ยังมีความสามารถในการ
ทํางานรวมกับวิดีโอได โดยสามารถใชตัดตอวิดีโอไดแตไมสามารถทําการตกแตงหรือใสเอฟเฟคใหกับวิดีโอได และในการใชงาน
รวมกันระหวางเสียงกีบวิดีโอน้ัน ขั้นตอนแรกที่ควรคํานึงถึงกอนที่จะทําการวางเสียงตองมีการตั้งคาเฟรมเรทของโปเจคใหถูกตอง
ดวย เพื่อใหการวางเสียงเพื่อประกอบวิดีโอสามารถวางไดอยางแมนยํา และถูกตองตามวิดีโอ นอกจากน้ีเสียงที่ถูกวางไดตรงตาม
ตําแหนงแลว เสียงยังตองมีคุณภาพทั้งดานความดังที่สมดุลและการตัดตอที่ดีและมีความตอเนื่องกันของเสียง โปรแกรม Nuendo 
นั้นจะมีความสามารถในการ Export วิดีโอไดแตก็มีขอจํากัดดวยเชนกัน คือสามารถ export ในรูปแบบของไฟลนามสกุล .mp4 
codec H.264 สวนทางดานเสียงจะไดความละเอียดที่ 16 bits 44.1 kHz และ 16bits 48 kHz ขนาดภาพที่ 1920 x 1080 px 
(Full HD) เทานั้น หากไฟลวิดีโอที่นําเขามามีขนาดที่เล็กหรือใหญกวานี้จะถูกปรับใหเปนขนาด 1920 x 1080 px (Full HD) 
เชนกัน เทานั้น ถึงแมวาโปรแกรม Nuendo นั้นเปนโปรแกรมที่มุงเนนทางดานการทําเสียงอยางมืออาชีพ แตในการใชงานใหได
ประสิทธิภาพที่ดี ผูใชงานควรฝกฝนทักษะในการฟง การวิเคราะหเสียงตางๆที่ไดยิน เพื่อใหไดเสียงตามที่ตองการและมีคุณภาพดวย 
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